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Overview of Q-teach Animal CO2 Package 

The Q-teach Animal CO2 package has been designed for teaching principles of animal respiration.  

The package contains all the components required, including this operational manual.  A Laboratory 

Manual is also included with the description and instructions of laboratory experiments for this 

package. The Laboratory Manual is in the editable form (Word) so instructor has the ability to make 

changes and additions as required by the curriculum. Before using this package, ensure that all the 

components are included and familiarize yourself with their function as described in this manual.  If 

any part of the package is missing, contact QUBIT SYSTEMS INC. immediately by email at 

info@qubitsystems.com or phone (613-384-1977).  Purchase of the Q-teach Animal CO2 Package 

entitles you to copy the software provided, or any part of the manuals, for use in your educational 

institution only.  You may not give, sell, or loan any part of the written or software components of 

the package to any other institution or person. 

The Laboratory Experiments manual provides detailed notes to the instructor with step-by-step 

instructions for performing 3 experiments. Examples of results are also provided.  At the end of each 

experiment, the students are assigned questions to direct them in the interpretation of their data, 

and the instructor’s notes provide the answers to these questions.  Instructors may wish to modify, 

add to, or delete these questions, as the laboratory manual is provided on a disk in a Word format 

for convenient editing. 

Students can use the Q-teach Animal CO2 Package to compare the metabolic rates of different 
organisms, investigate the effects of temperature and other environmental factors on metabolism 
and determine an organism’s metabolic rate during sleep and various levels of activity.  The 
Respiration Package also allows students to observe the metabolic effects of special diets, 
pharmaceuticals and exposure to various concentrations of O2 and CO2 in the animal’s air supply.  
Many different organisms may be used in these studies, lizards, amphibians, fish, insects, small 
mammals and yeast suspensions.  Three experimental investigations are fully described in the 
Laboratory Experiments manual.  These can be used as the basis for many other studies that 
students can pursue under supervision or as independent research projects. 

The Q-teach Animal CO2 Package includes a Q-teach 101 CO2 analyzer (0-2000ppm), Q-teach 201 

Gas Pump/Flow Monitor (1LPM), S132 Temperature Probe, G113-t Insect Chamber, G115-t Animal 

Chamber, G230 Aquatic head space chamber, G122 gas bags (2 x 30L), Q-teach kit (accessory kit 

with tubing, connectors, filters, valves, wrench, screwdriver, Qubitac sealant), G212 Water Trap for 

ice condensing bath, C610 Lab Quest Mini data interface (3 analog channels), C901 Logger Pro 

software, C404 USB disk with experimental files and manuals for this package.  For experiments with 

more active animals, like small mammals Q-teach Animal CO2/O2 Package may be considered.  

Contact Qubit systems for details.   

 

 

mailto:info@qubitsystems.com
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This manual contains detailed information about the components of this package and instructions 
on how to setup the system for teaching experiments.  Please note that this package is designed 
for teaching purposes only.  It is not a research quality package.  Each of the sensors has been 
calibrated in factory and no further calibration is required.    

 

Components of Q-teach Animal CO2 Package: 

 

Q-teach 101 CO2 Analyzer 0-2000ppm (drying and soda lime columns included) 

Q-teach 201 Gas Pump/Flow Monitor 1LPM 

S132 Temperature probe 

G113-t Insect Chamber (1.6cm ID, 10cm long) 

G115-t Animal Chamber (3.7cm ID, 15cm long) 

G230 Aquatic Head Space Chamber (8.5cm ID, 5cm active hight) 

G212 Water trap for ice condensing bath 

Q-teach kit (tubing, connectors, blue particulate filters (3), screwdriver, wrench, PTFE filters (2), 

Qubitac sealant) 

G122 Gas Bags (2 x 30L) 

C610 LabQuest Mini (3 analog channels) 

C901 Logger Pro Software 

C404 USB Disk with manuals and experimental files 
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Q-teach 101 CO2 Analyzer 2000ppm 

The Q-teach 101 CO2 Analyzer is a non-dispersive infrared gas analyzer (NDIR IRGA).  It has a “Gas In” and 

a “Gas Out” port on the front of the analyzer.  Please note that “Gas In” port should be connected with a 

female luer connector tubing and “Gas Out” port may be left with no tubing (as gas vents to atmosphere) 

or with male luer connector tubing.   The gas supplied to the IRGA passes through a sealed waveguide and 

vents from the “Gas Out” port.  The analyzer has two holders on either side for a drying column and a CO2 

scrubbing column.  These should be placed in upright position when in use and may be placed inside these 

holders. 

 

 
 

 
 

On the back of the Q-teach 101 CO2 analyzer the user will find the BTA data cable for connection to the 

LabQuest Mini data interface (channel 1) and a power supply connection.  A standard 12V power Supply 

with a 120/220 AC power adaptor is included with the analyzer.   

The gas entering the CO2 analyzer “Gas In” port is delivered by the Q-teach 201 Pump/Flow Monitor 1LPM.  

The maximum flow rated of gas into the CO2 analyzer should not exceed 650 mL/min. Flow rates of about 

Soda lime column (CO2 

scrubbing column) 

Drying column 

(filled with Drierite) 

BTA data cable 

Female luer 

male luer 
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50-150ml/min for measurements of insects and 100-250ml/min for measurements with lizards and 

amphibians are recommended.  For measurements with the aquatic head space chamber, flows between 

50-150ml/min is recommended for fish measurements and 200-400ml/min for yeast measurements.   

Gases entering the Q-teach 101 CO2 analyzer must be clean and dry, since particulate matter may absorb 

infrared light and cause erroneous readings.  Water vapour will not interfere with the IR absorption 

measurement of CO2, but water vapour will dilute the CO2 concentration.    The CO2 analyzer is supplied 

with a short drying column containing blue DRIERITE.  This drying agent removes moisture from the 

analysis gas before it enters the CO2 analyzer.  Wool plugs at the base and top of the column prevent 

particulate matter from leaving the column.  The drying column should be attached to the CO2 analyzer 

“Gas In” port via a small blue tubular particulate filter (25µm).  This filter will prevent any particulate 

matter from getting inside the analyzer. Three of these filters are include with the Q-teach Accessory Kit.  

Over time these filters may get plugged up with particulates, but they can be cleaned by washing them in 

water and blow drying them with compressed air. 

The Q-teach 101 CO2 analyzer requires a 15 to 30-minute warm-up period with air running through the 

analyzer.  When used over a period of few days or weeks it is recommended to keep the analyzer powered 

continuously (with the gas pump turned off) for better stability of the signal.  If running a teaching 

laboratory, it is recommended that the teaching assistant set up the analyzers before the laboratory 

session begins so that the analyzer is warmed up. Once the analyzer has warmed up it may be connected 

to the LabQuest Mini data interface (channel 1) for data collection. 

The Q-teach 101 CO2 analyzer has a linear response to changes in CO2 levels.  The linear response is 

delivered with the analyzer’s factory calibration.  No further calibration by the user is required.  Calibration 

constants have been entered in the experimental setup file (Q-teach Animal CO2 Setup) and the voltage 

reading is converted into ppm of CO2 in the software.  However, before the start of an experiment, it is 

recommended to check the zero CO2 reading and adjust it if required.  This is done by connecting the CO2 

scrubbing column (long white column filled with soda lime) to the “Gas In” port on the analyzer 

(maintaining the drying column and the blue filter connection as described above.  The soda lime will be 

attached before the drying column in line to the analyzer as per diagram below: 
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Soda lime will scrub CO2 from the room air delivered to the analyser and a reading of zero CO2 should be 

observed in the CO2 meter of the experimental file (bottom left-hand side).   

 

To open the Logger Pro software and visualize the CO2 readings it is necessary to follow the instructions 

below on how to load the software, connect the sensors and use the experimental setup file (pg. 17-19). 

When the CO2 reading in the software (CO2 meter on page 1 of the experimental file) stabilizes but is not 

zero, the user can adjust the “CO2 Zero” on the front panel of the analyzer using the small flat screwdriver 

provided with the Q-teach Accessory Kit. Turning the screw clockwise will increase the reading and 

anticlockwise it will reduce the reading.  Once the zero CO2 has been set, one can start the experiments.  It is 

recommended to check the zero CO2 at the beginning of each experiment and at least at the beginning of the 

day and at the end of the day to ensure no changes. The Q-teach 101 CO2 analyzer is sensitive to big 

temperature and pressure changes therefore we recommend using it in temperature-controlled laboratory. 
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Remove the soda lime scrubbing column before starting the experiments unless background air needs to be 

CO2 free. 

Soda Lime and Drying Columns 

The Q-teach 101 CO2 analyzer is designed to analyze dry gas samples and has been calibrated in factory 

with dry gases.  A short drying column is provided which is filled with DRIERITE to dry the gas before 

analysis.  The column has a wool plug at both ends to prevent particulates from being carried through the 

system. It is supplied ready for use.  The column should be mounted vertically on the side of the CO2 

analyzer with the gas in port (female luer) at the bottom and gas out port (male luer) at the top. 

DRIERITE contains an indicator that is blue when the column is functional and pink when the DRIERITE is 

saturated with absorbed water vapour.  When spent (pink), the DRIERITE should be replaced or 

reconditioned.  To recondition, remove the DRIERITE from the column and place it in a drying oven at 210 
°C for 1 hour, or until the blue coloration reappears.  Note that it will be paler blue color after 

regeneration.  The replacement DRIERITE is #8 mesh, order #23005 from DRIERITE.com.   

To extend the life of the drierite during experiments it is recommended to use the condensing ice bath 

before gas exiting the animal chambers enters the drying column as mentioned below. 

Soda lime column is used to scrub CO2 from air.  It is the long column filled with white soda lime.  A small 

amount of wool is placed at the ends of the column to prevent particulates from getting into the gas 

stream. The soda lime column should be used in a vertical position to ensure the gas has maximal contact 

with the crystals when flowing through the column.  This is achieved by placing the column in one of the 

holders on the side of the Q-teach 101 CO2 analyzer. Again, the gas in port (female luer) should be at the 

bottom and gas out port (male luer) should be at the top. 

The soda lime provided with the CO2 analyzer has a coloured indicator to show when it is saturated with 

absorbed CO2.  The soda lime should be replaced when most of it has changed from its original white 

colour to a pale purple.  This colour change is subtle, and the purple coloration often does not persist, but 

appears as a band in the column at the junction between active and inactive soda lime.  Replacement 

supplies may be obtained from Fisher Scientific (product #S200I-3) or other chemical supply company.  

Warning: Soda lime can cause burns and should be handled with gloves.  Users should read and comply 

with the Material Safety Data Sheet supplied with the soda lime.  

G212 Water Trap for Condensing Ice Bath 

Because gas leaving the animal chamber (especially the head space aquatic chamber) is high in water 

vapour it is recommended to also use an ice condensing bath before gas enters the drying column.  A 

water trap vessel (G212) is included in the package for this application. It should be connected to the 

tubing with gas that is exiting the chamber after the PTFE filter.  The outport of the vessel should be 

connected to the tubing of the drying column before the CO2 analyzer.  The vessel should be placed in a 

beaker with ice.  This will allow the water vapour to condense out of the gas that enters the vessel and 

prolong the lifespan of the drying column. 
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 Q-teach 201 Pump/Flow Monitor 1LPM 

The Q-teach Animal CO2 Package comes with the Q-teach 201, which is a gas pump and flow monitor 

combination.  The gas pump can generate flow rates of up to 1LPM and the mass flow monitor can 

measure these as voltage changes. The voltage output from the flow monitor is delivered via the data 

cable with a BTA connector (on the back of the unit) to the Lab Quest Mini data interface (channel 3) and 

is read in the software. The voltage output is linear, and the flow monitor has been calibrated in factory.  

No further calibration is required.  Calibration coefficients used to convert voltage into flow rate (LPM) 

are incorporated in the experimental Setup file (Q-teach Animal CO2 Setup) provided.  To use the Q-teach 

201 ensure that the power supply provided with the device is plugged in and the power switch on the 

front of the unit is in the “on” position.   

The Q-teach 201 Pump/Flow Monitor has one set of “In” and “Out” ports associated with the gas pump 

(top) and a second set associated with the flow monitor (bottom).  Four pieces of tubing with luer 

connectors are delivered with the unit.  It is important to connect the tubing with female luer connector 

to the “Gas In” ports and the male luer connector tubing to the “Gas Out” ports.  The gas from the source 

(gas bag) should be connected to the pump “In” port via a blue tubular particulate filter (to keep the gas 

entering the system free of debris).  The pump “Out” port is connected with the flow monitor “In” port.  

The flow monitor “Out” port delivers the gas either directly to Q-teach 101 CO2 analyzer (during reference 

gas measurement) or to the animal chamber first and the output from the chamber is carried to the CO2 

analyzer.  The flow rate of the Q-teach 201 Pump/Flow Monitor is controlled by the needle valve on the 

front of the instrument. 
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The flow rate of the Q-teach 201 Pump/Flow Monitor has been set at factory around 150ml/min.  This 

may need to be adjusted depending on which animal chamber is used for measurements and the activity 

of the animal.  Flow rates of about 50-150ml/min for measurements with insects and 100-250ml/min for 

measurements with lizards and amphibians are recommended.  For measurements with the aquatic head 

space chamber, flows between 50-150ml/min is recommended for fish measurements and 200-

400ml/min for yeast measurements.   

Increasing the flow rate will reduce the CO2 signal and decreasing the flow will increase the signal (and 

sensitivity).  Before changing the flow rate ensure that the Q-teach 201 is connected to the LabQuest Mini 

data interface and the Logger Pro software, and the experimental file (Q-teach Animal CO2 Setup) is open 

(see pg. 17-18 for instructions on setting up logger pro and C404 disk files).  This file is found on the C404 disk 

supplied with the package. The flow rates may be observed in the meter labelled “Flow” on page 1 of the 

experimental Setup file as shown below: 

 

To increase the gas flow, turn the needle valve anticlockwise and to decrease the flow turn it clockwise.   
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S132 Temperature Probe    

The temperature sensor S132 included with this package is a semi-conductor device mounted on the end 

of a stainless-steel probe.  It is inherently linear with an operational range from –40oC to +125oC.  The 

temperature sensor does not require calibration.   It is also automatically recognized by the software 

when plugged into the LabQuest Mini data interface and calibration is loaded when the experimental file 

(Q-teach Animal CO2 Setup) is opened.  The sensor is mounted on a stainless-steel support, which fits 

through the temperature sensor ports in animal chambers supplied with this package.  Two small o-rings 

are placed on the probe and should be pushed tightly into the chamber probe port by the white sleeve 

around the probe.  This will ensure a good seal around the temperature probe and no leaks from the 

chamber.  The temperature sensor port in the chambers must be plugged with a solid stainless-steel 

stopper when the sensor is not in use to prevent gas leaking out of the chamber. 

 

The S132 temperature sensor may be used to measure temperature inside the animal chamber or the 

temperature of the environment where experiments are being conducted.   

G122 Gas Bags  

This package is delivered with 2 x 30 L heat-sealed gas bags.  These are made from a gas-impermeable 

nylon-polyethylene laminate.  Tygon tubing with a locking valve is attached to each bag by a luer-lock 

fitting.  The fitting on the other end of the tubing attaches directly to the fittings on the Q-teach 201 Pump 

“In” port.  The gas bags can be filled with air from a compressor (or another gas mixture from a commercial 

tank) to provide a constant source of CO2. When measuring CO2 respiration activity of any organism, it is 

crucial that the background levels of CO2 (reference or incurrent CO2 level) is constant.  This is achieved 

by using gas bags to deliver background gas to the animal. Outside air has a constant level of CO2 (close 

to 400 ppm) and may be used directly with a long piece of tubing connected to the Pump “In” port and 

the other end hanging out the window.  If this is not possible then gas bags should be filled with outside 

air and used as the background gas in experiments. Inside air in the lab can vary several hundred ppm in 

CO2 due to human activity and should not be used in experiments directly unless higher CO2 levels are 

required for the experiments.   

To fill the gas bag with air connect the gas “out” port from the Q-teach 201 Pump to the bag inlet and 

increase the gas flow rate to maximum (opening the needle valve to maximum gas flow).  Bags may also 

Stainless steel 

stopper 

white sleeve 

Two o-rings 
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be filed with compressed air from the compressor or a gas tank.  Bags should not be overinflated, as this 

can cause weakening of the seams and eventual leakage.  After use, the bags should be fully deflated, 

preferably by attachment to a vacuum-line or to pump “In” port.   

 

 
  

 

 

Animal Chambers 

The Q-teach Animal CO2 Package includes 3 animal chambers.  The G113-t is the insect chamber.  It is ideal 

for small animals such as insects.  The inside diameter of the chamber is 1.6cm and the length is 10 cm.  This 

chamber has two removable end caps that fit on the outside of the plycarbonate clear tubing and the seal is 

made with O-rings that fit on the inside of the end caps. Each end cap has one gas port with a removable 

piece of tygon tubing with a luer connector at either end.  The male connector is used on the gas “Out” port 

(connected to the CO2 analyzer) and the female connector is used on the gas “In” port (connected to the Q-

teach 201 Flow Monitor “out” port). One end cap also has the temperature probe port that should be plugged 

with the stainless-steel rod plug when temperature probe is not used. 
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G113-t 

 

For larger animals, like lizards and amphibians G114-t animal chamber is included in the package.   This 

chamber has a 3.7cm ID and active length of 15cm.  The two end caps fit on the inside of the polycarbonate 

tube and the length of the tube that is available for the animal is 15cm. Similarly, to the insect chamber there 

is one gas port at each end cap supplied with removable piece of tygon tubing and luer connectors.  Again, 

one end cap also has the temperature probe port that should be plugged with the stainless-steel rod plug 

when the temperature probe is not connected. The seal between the end caps and the tubing is made with 

double O-rings at each end.  A small amount of vacuum grease is included with each chamber.  This may be 

used to coat the O-rings and aid in the sliding of the endcaps into the tubing.  Apply only very thin layer of 

the vacuum grease on the O-rings if needed to avoid a messy setup. 

 

G115-t 

 

The final chamber of this package is the aquatic headspace chamber G230.  This chamber has been designed 

for measurements of head space CO2 levels above the liquid with an aquatic animal like a fish or suspension 

Stainless 

steel rod plug 
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of cells like yeast.  This chamber is constructed with 8.5cm ID polycarbonate tubing on a flat base and comes 

with only one end cap that hosts two gas ports and a temperature port.  Gas “In” port is connected to a piece 

of tubing with a diffuser for delivery of gas to the liquid.  Both, gas “in” and “Out” ports have a small piece of 

tubing with luer connectors for gas delivery to the chamber and out of the chamber.  Again, when the 

temperature probe is not used with the chamber the temperature probe port should be plugged with the 

stainless-steel plug provided. 

G230 

 

. 

 

When using the G230 chamber and measuring head space CO2 levels above liquid it is important that a head 

space of at least 1.5 cm depth is maintained. It is also crucial that the gas “Out” port tubing is connected to 

the CO2 analyzer via the circular PTFE filter which will trap any water that may enter the lines and prevent 

it from getting inside the CO2 analyzer and damaging it.   

Qubit System is not responsible for any damage to the CO2 analyzer when the system is used without the 

PTFE filter. 

PTFE filter will stop water and will also stop the gas flow.  If this occurs remove the PTFE filter from the line 

and blow out the water with some dry compressed air.  The filter may be used again once the water has been 

removed. 

When animal chambers are not in use please remove the end caps from the polycarbonate tubing and store 

them disassembled.  This will prolong the life span of the O-rings on the end caps. 

LabQuest Mini Data Interface 
 

The Q-teach Animal CO2 Package comes with one LabQuest Mini data interface.  This interface has 3 analog 

and 2 digital channels. The interface is connected to the computer (PC or Macintosh) by a USB cable. The USB 

cable is used to transfer data to the software and to power the LabQuest Mini.  The interface converts the 

analog voltages (12-bit A to D) from the sensor to digital signals which are transmitted to the computer via 

PTFE 

filter 
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USB and processed by the Logger Pro software. The digital channels can be used and programmed in 

LoggerPro with a Digital Control Unit (not included), for instrument control based on input data crossing a 

threshold.  This package only uses the analog channels.  The complete guide to the use of LabQuest Mini is 

included with the package on the C404 disk.  This manual only provides a general outline of the use and 

capabilities of LabQuest Mini data interface within the scope of this package.  

 

 

The 3 analog channels are used to connect the sensor of this package in the following order: 

Channel 1 – Q-teach 101 CO2 Analyzer 

Channel 2 – S132 temperature probe 

Channel 3 – Q-teach 201 Flow Monitor 

Only the temperature probe is automatically recognized when the experimental Setup file is open.  The CO2 

analyzer and Flow monitor need to be manually selected as described below on pg. 20. 

Q-teach Kit of Accessories 

The Q-teach Animal CO2 Package comes with the Q-teach kit of accessories.  These include extra tubing, luer-

lock connectors, extra Drierite, PTFE filters, blue Qubitac sealant, flat screwdriver, blue tubular 25um 

particulate filters, two 3-way valves and in some cases a small wrench. 
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The blue Qubitac sealant is useful if leaks develop anywhere in the system.  This sealant may be easily applied 

and removed after the experiment.  It is of playdough consistency and may be used over and over many 

times.  The blue particulate filters should be attached to the gas in port of the CO2 analyzer and the gas pump 

to prevent any particulate matter from entering the system.  These can get plugged up over time but may be 

washed out and blew out with compressed air to be used again.  In the early versions of the Q-teach package 

the Q-teach 201 pump/flow included a lockable valve for changing the flow rate through the system.  To 

adjust the valve a locking ring had to be loosened first.  A small wrench is provided in the Q-teach kits for use 

with the lockable valve.  Two 3-way valves are also included.  These may be used to redirect the flow of gas 

to bypass the animal chamber for reference CO2 (iCO2) measurements.  If used with the system, the flow of 

gas through the animal chamber is stopped temporarily and this period should be kept as short as possible, 

so CO2 does not build up in the animal chamber to high levels. 

 

 

 

 

The diagram below and photos above show how the flow may be redirected using the 3-way valves. 

 

Valves deactivated - gas 

supplied to leaf chamber 

for analysis measurements 

 

Valves activated - gas 

bypassing the leaf chamber 

for reference measurements 

 



17 

 

 

 

 

 

 

 

 

Logger Pro 3 Installation 

Logger Pro software is delivered with the package on a CD and requires a CD drive to load onto a computer.  

If the CD drive is not available, please contact Qubit Systems for alternative solution. This software can run 

on both PC and Mac computers and the licence allows use on as many computers per institution as required.  

Therefore, all students that are using this package may obtain copies of the software on their personal 

computers.  Free updates of this software are regularly released and may be accessed directly from the 

manufacturer website at the following link: 

https://www.vernier.com/downloads/logger-pro-updates/ 

 

PC Users:  

  

(1) To use this package, a complete copy of Logger Pro 3 must be installed on the computer.  Before 

starting the installation, make sure all USB cables are disconnected from the computer.  Failure to 

do so may cause an error in the installation of the USB drivers.  

(2) Run the installation and do not change the default destination directory.  Logger Pro 3 will be 

installed in C:/Program Files/Vernier Software/Logger Pro 3.  

(3) The setup process will automatically load the USB drivers for connecting the LabQuest Mini to the 

computer.  

(4) If QuickTime 6 (or greater) is not installed on the computer, install it when prompted.  QuickTime 

will allow use of the picture and movie features of Logger Pro 3.  

(5) You will be prompted to connect the LabQuest Mini or other interfaces to the computer via the USB 

connection.   

(6) Click ‘Finish’ to complete the installation process.  

(7) Proceed to C404 disk installation (below) before opening the Logger Pro. 

(8) Double click the “Q-teach Animal CO2 Setup” file (create a shortcut on the desktop once moved 

from the C404 disk for easy access) to start Logger Pro and data collection. When Logger Pro detects 

the LabQuest Mini interface, the Logger Pro screen will appear with a star icon in the top left corner.  

  

  

Gas 
Source 

Pump/ 
Flow 

Monitor 

CO2 
Analyzer 

filter 

filter drier 

Animal 
Chamber Manual 3-way valves 

https://www.vernier.com/downloads/logger-pro-updates/
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(9) If Logger Pro cannot detect the LabQuest Mini Interface, a message will appear “no device 

connected”.  Check that the LabQuest Mini is attached to the computer directly via USB cable.  The 

LED power lights on the Mini should be green.  No LED light indicates that power is not supplied to 

the Mini - check the USB cable connection as the power is supplied via this cable directly from the 

computer.  A red LED indicates that power is on but there is no communication between the 

interface and the software.  In this case, exit the experimental file and disconnect the USB cables 

from the computer.  Reconnect the USB cable and reopen the “Q-teach Animal CO2 Setup” file.  You 

may try different USB port in case the problem is with the computer. 

 

 

C404 Custom Setup Files Installation:  

 

Qubit Systems’ C404 USB disk contains experiment setup file (designed by Qubit Systems) for this package (Q-

teach Animal CO2 Setup).  This file is composed of 4 pages.  Page 1 shows the raw data collected from the 

sensors and pages 2, 3 and 4 contain calculations for experiments 1, 2 and 3.  Students collect all the data first 

and then do analysis and calculations on pages 2, 3 and 4 after completion of the experiment.  The C404 disk 

also contains the pdf file of this operational manual and a word (editable) file of Laboratory experiments 

manual for this package.  Also included is the manual for the LabQuest Mini data interface. These files can be 

copied to user specified location on the computer and the experimental setup file should be placed in an 

accessible location or have a shortcut created on the desktop to the file.  We highly recommend for the user 

to make a copy of the original files and keep them in a safe place on the computer in case the originals are 

accidentally altered. 
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Quick Start-up: 

1. Read this operational manual (pdf file on the C404 USB disk) to become familiar with all the components 

before setting up and using the package. 

2. Load Logger Pro software on the computer (follow instructions pg. 17) 

3. Copy experimental setup file “Q-teach Animal CO2 Setup” and the manuals from C404 disk to the 

computer. 

4. Set up all the components of the package as shown in the diagram below and connect the sensors to the 

correct analog channels on the LabQuest Mini as indicated by the window below: 

 

 

Please note that the gas bag and the animal chamber do not need to be connected to the system while the 

system is warming up. 

 

 

5. Power up and turn on the Q-teach 101 CO2 analyzer and the Q-teach 201 Pump/Flow Monitor and allow 

the CO2 analyzer to warm up for at least 15-20 min while running room air across the sensor. 

6. Open the “Q-teach Animal CO2 Setup” file.  The following screen will appear: 
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7. Connect the CO2 Analyzer to channel 1 and the Raw Voltage of the Flow monitor sensor to channel 3 on 

the LabQuest Mini in the software.  The Stainless-Steel temperature probe will already be automatically 

connected and listed in the “active sensors” list. 

8. The following screen will be shown in the software once the sensors are connected.  This is page 1 of the 

software where all the raw data will be displayed: 

 

 

The CO2, flow rate and temperature data will be shown in the top menu and the meters at the bottom of 

the page.  Once the collection of data is started (green button “Collect” clicked), the table and graphs will 

also populate with the logged data. 
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9. While the CO2 analyzer is warming up the flow rate through the system should be set up as described 

above on pg. 9.  Briefly, turn the valve on the Q-teach 201 pump/Flow monitor clockwise to reduce the 

flow rate and anticlockwise to increase the flow rate through the system. 

10.  After CO2 analyzer has warmed up and the flow rate has been set, check the zero by connecting the 

soda lime column (long white column) to the gas “out” port of the flow monitor of the Q-teach 201 and 

attach the out port of soda lime column to the drying column and the CO2 analyzer (as shown in the 

diagram below).  

 

 

11. Allow the scrubbed room air to enter the CO2 analyzer and observe the CO2 signal in the software drop 

to zero.  When the reading stabilizes but is not at zero adjust the “CO2 zero” screw on the analyzer with 

the screwdriver provided in the Q-teach kit as described above in the manual on pg. 7). Briefly turn the 

“CO2 zero” screw clockwise to increase the reading and anti-clockwise to reduce the CO2 reading. 

12.  Once CO2 zero has been established and adjusted, connect the gas bag filled with outside air to the 

pump “in” gas port on the Q-teach 201 and observe the CO2 signal in the software rise to approximately 

400ppm.  Once this signal stabilizes the system is ready to use for experiments with animals. 

13. Always measure background levels of CO2 (reference, or incurrent CO2) for few minutes before starting 

measurements with animals as these will be used in calculations of metabolic rate later. 

14. Before starting data collection in each experiment, select the time icon to set up experiment duration 

and data collection frequency 
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15. The following window will appear.  Input experiment length and data sampling rate as required.  The 

default is 1 sample per sec or 60 samples per min. 

 

 

 

16. Save experimental file under a new name following each experiment so the original setup file is not 

accidently overridden. 

17. To start data collection, click the “Collect” green button in the top menu.  To stop data collection, click 

the red “Stop” button (collect button will turn red during data collection). 

18. Once the data has been collected the experimental file should be saved under a new name by selecting 

File>Save As from the top menu or clicking on the disk icon. 

19. Saved data may be analyzed later with the various analysis tools available in Logger Pro.  Pages 2, 3 and 

4 of the experimental setup file contain calculations for the laboratory experiments listed in the 

laboratory manual of this package.  Data may also be exported for opening in a spreadsheet program by 

selecting File>Export As>CSV 

20. Calculations of the metabolic rates from the collected data are described below and may be done page 

2, 3 or 4 of the setup file.  Page number may be selected in the top menu. 
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21. To proceed with specific laboratory experiments please refer to the Laboratory Experiments for Animal 

CO2 Package Manual included on the C404 disk.  

 

Calculations of Metabolic Rate  

All the raw data collected in the software is shown on page 1 of the Q-teach Animal CO2 Setup file.  It is 

displayed in the table and graphs.  The print screen below shows an example of experimental data with 4 

superworms placed in the insect chamber and exposed to changes in temperature. 

 

 
 

To calculate the metabolic rates from raw data the user needs to enter the average raw data from page 1 

on pages 2, 3 or 4 in the experimental Setup file.  All the calculations of metabolic rates at specific times 

during the experiment are done on pages 2, 3 or 4 depending on the experiment.  The average raw data 

is obtained by first clicking to highlight all the graphs (hold shift key and click on each graph) and then 

dragging the mouse over the selected data to select it (see print screen below).  Various analysis icons 

may then be selected from the top menu to obtain the data required.  In this case selecting the “statistics” 

icon will result in popup windows with all the statistics for the selected data including the mean values 

that need to be manually entered on pages 2, 3 and 4. 
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When the mean values of CO2, Flow and Temp are entered on page 2, 3 or 4 of the Setup file the metabolic 

rate will automatically be calculated.  The print screen of page 2 is shown below: 

 

 
 

Data is entered in the red columns and black columns will populate automatically with calculated 

numbers.   
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Metabolic rate is calculated as CO2 produced per unit time ( CO2) in the units of µL /min.  

Respiratory Quotient, RQ, is the ratio of CO2 produced to O2 consumed (i.e. RQ= CO2/  O2). It is directly 

related to the animal’s diet and metabolic condition.  RQ is usually less than 1.0, which means that more 

O2 is consumed than CO2 is produced.  When only CO2 is measured an assumption about the RQ value 

must be made.  The assumed RQ value is assigned by the user in the table on page 2 of the Experiment 

setup file.   If the diet is not known, an assumption of RQ of 0.85 is most appropriate. 

The incurrent and excurrent CO2 is measured by the Q-teach 101 CO2 analyzer.  When the animal chamber 

is not connected to the system and only background gas is being measured that is incurrent or reference 

levels of CO2 (iCO2).  When the animal chamber is connected to the system and the animal is inside it, 

then excurrent levels of CO2 (eCO2) are being measured. These are used to calculate the fractional 

concentrations of CO2 that enters and exits the flow through animal chamber.  These values are obtained 

directly from the raw data by manually highlighting the data collected in the reference mode (no animal 

chamber) and later with the animal in the chamber.  Description of this may be found above.  Once the 

statistics icon in the top menu is selected the pop-up window will show all the statistics including the mean 

value of CO2 for the selected raw data.  The print screen of one of the pop-up windows is shown below.  

Enter the mean value from this window on pages 2, 3 or 4 in appropriate column (iCO2 or eCO2). 

 
 

The same procedure is followed for obtaining other mean raw data with the animal in the chamber.   

 

Since the flow monitor in this package is upstream of the CO2 analyzer and O2 is not removed from the 

excurrent gas stream at any point, the following equation is used to calculate CO2:   

(http://warthog.ucr.edu/WartHogPage/LAX%20website/respirometry.html)  

  

CO2 = (FeCO2 – FiCO2) * FR/(1 – FeCO2 * (1-(1/Assumed RQ))) 

Where FeCO2 is the fractional excurrent CO2 concentration, FiCO2 is the fractional incurrent CO2 

concentration and FR is the gas flow in mL/min.    

FeCO2 = eCO2 in ppm/1000000 

FiCO2 = iCO2 in ppm/1000000 

.   

The summary data is also graphed on pages 2, 3 and 4 of the setup file once calculations have been 

completed.  If more data needs to be added to this table for example treatment, proceed to the top menu 

and select Data>New Manual Column and the following window will appear: 
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Enter the name of the column and short name plus units and click done.  The new data column will appear in 

the table.  Data may be entered in this column and then used to graph metabolic rate in a summary graph.  

To create a new summary graph, click in the top menu Insert>Graph.  A new graph will appear on that page.  

Right click on the graph to give it a title.  Click on Axes Options tab to select which column (parameters) to 

graph. Logger Pro software provides numerous analysis and data display functions.  It is very user friendly 

and has an extensive Help menu.  Always save the new modified data file under a new name so the original 

is not overridden. 

 

Qubit Systems Warranty Information  

QUBIT warrants all its instruments to be free from defects in materials or workmanship for a period of 

one year from the date of invoice/shipment from QUBIT.   

If at any time within this warranty period the instrument does not function as warranted, return it and 

QUBIT will repair or replace it at no charge. The customer is responsible for shipping and insurance 

charges (for the full product value) to QUBIT.  QUBIT is responsible for shipping and insurance on return 

of the instrument to the customer.      

No warranty will apply to any instrument that has been (i) modified, altered, or repaired by persons 

unauthorized by QUBIT; (ii) subjected to misuse, negligence, or accident; (iii) connected, installed, 

adjusted, or used otherwise than in accordance with the instructions supplied by QUBIT.    

The warranty is return-to-base only, and does not include on-site repair charges such as labour, travel, or 

other expenses associated with the repair or installation of replacement parts at the customer’s site.   

QUBIT repairs or replaces the faulty instruments as quickly as possible; maximum time is one month.   

QUBIT will keep spare parts or their adequate substitutes for a period of at least five years.   

Returned instruments must be packaged sufficiently so as not to assume any transit damage. If damage 

is caused due to insufficient packaging, the instrument will be treated as an out-of-warranty repair and 

charged as such.   

QUBIT also offers out-of-warranty repairs. These are usually returned to the customer on a cash-on 

delivery basis.    
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Wear & Tear Items are excluded from this warranty. The term Wear & Tear denotes the damage that 

naturally and inevitably occurs as a result of normal use or aging even when an item is used competently 

and with care and proper maintenance.  

Qubit Systems also offer a service package for all the Q-teach Packages components, whereby once a year 

all of the components may be returned to Qubit for calibrations, service and minor repairs.  Contact Qubit 

Systems for details. 

Return Procedure  

Before returning any instrument to QUBIT:    

Consult the operating manual or contact Qubit to ensure that the instrument(s) is in fact faulty and has 

not just been set up improperly.   

Contact QUBIT before sending anything back.  We will issue an RMA number and provide shipping 

instructions.   QUBIT will refuse any goods that are returned without an RMA number, or which are sent 

in a manner outside of QUBIT’S stipulations.  

If you have encountered a program failure, we need a printed copy of any faults you have seen, including 

how to reproduce them.  Include these in the return package along with your mailing address.   

Include a copy of the Invoice on which the product was shipped to you.   

All returns must be shipped prepaid.  Unpaid packages will not be accepted.   

In case of questions contact QUBIT by 

E-mail: info@qubitsystems.com,  by 

phone: (01)-613 384 1977,  or by fax: 

(01)-613 384- 9118.  

 

 

 


